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About USEReady 

 
USEReady’s mission is to help users succeed with data. 
 
We achieve this mission with fanatical customer centricity, 
humility, and integrity. At USEReady, we love to solve customer 
problems, contribute to the community, and continue to 
improve. We aim to build a strong learning culture and have fun 
doing it together.  
 
We have harnessed modern Business Intelligence solutions with 
cutting edge Artificial Intelligence (AI) platforms to unlock the 
power of data. Our result-oriented solutions ensure that our 
customers are successful in adopting self-service technologies.   
 
We have partnered with the best in class BI, Data and Cloud 
products such as Tableau, Snowflake, Alteryx, 
Informatica, Exasol, AWS, and Azure. We have delivered proven 
success across Financial Services, Insurance, Retail, and Media 
verticals.  
 
Check us out at  www.useready.com or e-mail 
contact@useready.com. 
  

http://www.useready.com/
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processes under one platform in a bid 

to help organizations transform at an accelerated pace. Today, 
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Alteryx, thank you. I would also like to thank Laxmi Shankar and 
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to Subrat Das, Murtaza Farooqui, and Sharang Kulkarni.   
 
At USEReady, we pay very close attention to the reaction and 
responses we receive from our readers. As per requests received 
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regarding USEReady’s other guides published - we have further 
included additional hands-on exercises, upgraded product 
features, and new chapters for users learn from. 

Feel free to drop by https://www.resources.useready.com where you 
can explore extremely useful exercises that are beneficial to 

fellow Alteryx practitioners. 

Apart from keeping our ears pressed to the ground when it 
comes to listening to our readers – we are also highly aware of 
the environment that we operate within and the ecosystem we 
are a part of. Right now, this means functioning in a world that 
is going through a pandemic. 

Unemployment is through the roof, people who have lost their 
jobs and need to upgrade their skills will see an immense benefit 
when it comes to using this book. Simultaneously we are also 
witnessing a steady increase in the number of people working 
from home, people now have a lot more free time which they 
can put to good use for development and up-gradation of their 
skills. 

Learning and innovation must and will never stop, we must find 
new and better ways to power through as we understand how to 
pivot and readjust our thought process. 

With that being said, we have decided to make this book 

completely free for everyone moving forward. 

It took a lot of people and a collective effort in preparing this 
book - we are very grateful to have Alteryx part of the 
process and having put in the effort to help us review this 
book on priority and extremely quickly. They have enabled us 
to push this book into the market for our readers in a much 
shorter time than earlier anticipated.

https://www.resources.useready.com
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Letter from the CEO 

 
It’s my pleasure to introduce our 
readers to the latest and up to date 
publication on, Alteryx.  
 
A public company, Alteryx has 
gained widespread adoption across 
industries and geographies - we are 
thrilled to have partnered with this 
successful product that’s loved by all 
within the data community.  

 
We are witnessing a steady increase in adoption through the 
orders that we receive for this book. This version of Alteryx 
incorporates all the feedback and suggestions received we have 
received from our readers. Learn through practicality - as 
suggested by our previous readers, we have also incorporated 
additional hands-on exercises that’s based on real-world use 
cases that users can take.  
 
Many newly certified Alteryx practitioners at, USEReady have 
contributed and authored this book. Their hard work and 
dedication have resulted in this book being the finished and 
perfected manual it is.  
 
Revised by multiple practitioners, this book consists of upgraded 
product features, exercises, and new chapters dedicated towards 
helping users understand Alteryx in a comprehensive manner. 

The team has gone through great heights, ensuring that the 
content is extremely refined, straightforward, and easy to 
understand – with all the exercises proving to be extremely useful 
to a fellow practitioner. 
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Foreword 

 
Welcome to an incredible journey into 
the world of analytics! While people 
around the world have been using 
Alteryx for over 20 years, we are 
excited each time a new user joins our 
data science and analytics community  
and the legion of digital  
transformation experts.  
 
In this introductory book, USEReady 

quickly teaches you the core functionality of Alteryx including 
geospatial analysis and our rich data packages.  It features real-
world examples and solutions so relatable it’s as if the very same 
assignment just came through your inbox.  
 
Need your marketing program optimized by tomorrow 
morning?  No problem for those that have been through this 
course.  Need to re-engineer your financial consolidation 
processes with full automation on a timed schedule?  You may 
be on vacation the next time it needs to run, but that’s not a 
problem now because you’ve automated the entire process last 
night.  
 
By the time you finish working through this manual, as someone 
who has never opened the Alteryx Designer before, you will be 
able to create powerful workflows with data, design engaging 
reports, develop applications, and write macros to solve any data 

need. USEReady has leveraged extensive experience that enables 
diverse users at large enterprises to make powerful deployments 
of analytic tools.  
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I invite you to supplement this guide with the resources provided 
by Alteryx in the Alteryx Community (community.alteryx.com).  
In the Alteryx Community, you will find a wide array of free 
resources that include the ability to get help on questions, weekly 
challenges to continue exercising your new skills, certification 
courses, podcasts, local user groups, and more.  
 
This is an opportune time for people anywhere to make the best 
out of the unprecedented demand for data analytics with 
actionable information. Those who leverage these materials will 
be well on their way to accelerating their data know-how with 
Alteryx Designer. 
 
We appreciate the partnership with companies like USEReady 
that know how to help analysts reduce the time to insight with 
Alteryx. We are thrilled to welcome you to our community and 
hope that we can help you accelerate your journey with this 
guide.  If there is anything we can do to help, please reach out. 
 
Alan Jacobson 
Chief Data and Analytics Officer 
Alteryx, Inc. 
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Preface 

 
We are faced with options, questions, and choices every day. Our 
decisions, as we all know, are much easier to make when we’re 
well informed. Let’s say we want to eat. We literally have an 
entire world of possibilities, given the proper resources. 
However, practically, there are real limitations. Are we at home 
without transportation? Are we backpacking in the mountains? 
Are we in the middle of Times Square? Do we have food 
restrictions for health reasons? Do we have $5 or $5,000? What 
are we in the mood for? 
 
This task that we each solve day in and day out depends on a 
considerable amount of information we know and often take for 
granted. This information is all based on data about our world. 
 

What Is Data? 

Data is stored information. It comes in various forms—from the 
number and types of items on our desk to the total mass of the 
universe to the contents of this book to the information in digital 
files and systems. Data will be our focus. 
 

What Does Data Do? 

Data does nothing. It simply exists. It’s what we do with data that 
is important. When we look at data, we interpret it to create 
meaningful information, which gives us the ability to make 
better-informed decisions. 
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How Do We Consume Data? 

Data can be consumed in many forms. We can look at all the raw 
data and read every piece individually. We can use aggregation 
methods to create summary data so we can easily see high-level 
trends. We can visualize data. Since we often do not want to look 
directly at the original data source and reach each individual 
piece of data, we need to perform data preparation. 
 

Introduction to Data Preparation 

Data preparation is the process by which raw data is converted 
into a clean, usable source for later consumption. It is a process 
of standardizing the practice of data consumption, which helps 
create rich and insightful analysis.  
 
The three core components of data preparation are data retrieval, 
data manipulation, and data export. In more traditional analytic 
terms, data preparation refers to the extract-transform-load 
process referred to as ETL. However, in order to ease 
communication, we’re going to avoid these technical terms and 
discuss the aspects of the processes as follows:  
 

1.  Data retrieval refers to the process of going to a data source, 
asking for data, and returning the desired data.  
2.  Data manipulation refers to anything we decide to do to 
the data between the time we retrieve it and the time we 
export it.  
3.  Data export refers to what we do with data after we have 
extracted and manipulated it, even if we haven’t finished 
transforming it. 
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What Is Data Manipulation? 

Data retrieval and data export are straightforward. They can be 
likened to drawing water from a well and putting an ice cube in 
someone’s drink. However, data manipulation is that tricky 
process of running the water through the pipes into our house, 
filling the ice cube tray, putting the tray in the freezer, and letting 
the water have enough time to freeze so we have ice to consume. 
Going forward, we will use an analogy of a river to explain the 
entire process of data preparation and specifically data 
manipulation. 
 
Data manipulation can come in many forms, which typically fall 
into three buckets: combination, calculations, and transformation. 
 

Combination 

One of the most common problems with data is that it comes 
from multiple sources. It is generally possible to perform an 
analysis separately or through a significant amount of manual 
effort, but these methods often leave something to be desired or 
are too slow for effective use. In order to solve this problem, we 
will be designing data streams that come together. 
 
If we think about data streams as actual rivers, original data 
locations can be thought of as glacial streams, smaller rivers, or 
lakes. Bringing data together is like the tributaries that unite these 
different water sources to form a river. Along the course of this 
river, we can perform calculations. 
 

Calculations 

If the data is to be used, it is generally advisable to have as much 
data pre-calculated as possible. One reason is because it allows 
an organization to create a standardized formula for everyone’s 
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use. Another reason is because when we can run calculations 
before data is provided to a front-end user or system, the 
consumer will experience a much faster process. 
 
If the data is to be used in a report, then the calculations are often 
fundamental aspects of that report. 
 
Returning to the river analogy, we can think of calculations as 
hydroelectric dams along a river. We are using existing resources 
in order to generate something new. 
 
Because we’re changing the flow of the water, we might be 
changing the landscape and also slowing down the river 
(introducing calculations will slow down the data preparation 
process). We also have the ability to transform the data stream 
into a more usable format. 
 

Transformation 

It is often the case that data is not in the format we need. We may 
have been given access to a database with data stored in a very 
machine-readable format, and we need to pivot the table to make 
it human-readable. Or we may have been working with an Excel 
file that has data extremely normalized, making it hard to use in 
a front-end system. Either way, we need to transform the 
structure of the data so it can be effectively consumed. Back to 
the river analogy, we can imagine this as the process of cutting a 
channel into the riverbed so the river is deep enough to move 
barges up and down. In doing so, we’re fundamentally changing 
the structure of the river in order to make it more usable. 
 
The Alteryx Analytics Platform was built with the above points 
in mind. It helps the user automate the manual data task using a 
repeatable analytic workflow approach, which is code-free and 
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helps the user focus on gaining insights from data and not spend 
time cleaning and preparing the data. It has solved two major 
issues affecting the data preparation process: time to run the 
process and high specialization of labor. Typically, the 
preparation process is highly time-intensive because it is largely 
manual, it requires skilled individuals, and it is time consuming. 
Alteryx, Inc. has elegantly addressed both problems. It has 
designed an easy-to-use, drag-and-drop interface where all you 
need to do is give each tool the appropriate settings. This simple 
concept has allowed business users to develop workflows to 
meet their needs much faster than has ever been possible. It 
provides them with the tools to design or modify a fully or semi-
automated data preparation process. 

Historically, much of this task has been done with Excel 
spreadsheets. Companies have employed armies of analysts to 
help prepare and clean data, which, in turn, meant high cost of 
headcount and low employee morale, and that affected 
productivity. The introduction of Alteryx into such ecosystems 
has generally transformed the mindset of its workforce. 
Individuals now feel empowered to glean insights from the data 
at the speed of thought, and it has brought back the joy of 
learning and exploration to its user that has improved overall 
productivity and insights gained. Companies have seen tangible 
returns on investment in every scenario where the Alteryx 
Analytics Platform has been used. 
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To the Reader 

In the following chapters, we are going to cover many topics, but 
the format of the chapters will be the same. 

You will assume the role of a new consultant at a company that 
works with Alteryx. We will introduce a business scenario, 
discuss the tools we’ll use to solve the problem(s), walk through 
the initial problem(s), and then provide you with a self-guided 
exercise. We will conclude this book with a capstone assignment 
in New York City. 

The exercises will use data that can be downloaded from 
https://resources.useready.com/publications by 
following the instructions on the website to unpackage 
the file. 
Additional data will also be needed to install the U.S. 2010 Census 
SF1 and USGS North America Map packages from 
http://downloads.alteryx.com/data.html, which we will start 
using in Cultural Musings. We will also be using the Solocast data 
sets in the Statistics in Alteryx section. 

Let us know what you think by e-mailing us at 
publications@useready.com. We will try to incorporate reader 
requests going forward. 

If interested in Alteryx training sessions or Alteryx consulting, 
visit www.useready.com 

Best regards, 
USEReady 

http://downloads.alteryx.com/data.html
mailto:publications@useready.com
http://www.useready.com/
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CHAPTER 1 

 
An Introduction to Alteryx 
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1.1   What Is the Alteryx Analytics Platform? 
 
The Alteryx Analytics Platform from Alteryx, Inc. consists of four 
products: Alteryx Designer, Alteryx Server, Alteryx Connect, and 
Alteryx Promote. 
 
Alteryx Designer allows us to build a data stream (or module) and 
run it locally. In addition to a base package, Alteryx offers data 
sets and tool packages to expand the product to enhance 
computing capabilities. These packages permit additional 
features such as drive-time analysis when TomTom data is 
available. 
 
Alteryx Server has two main functions. The first allows users who 
have Alteryx Designer to publish applications for consumption. 
The second allows scheduled workflows to run without external 
intervention.  
 
Alteryx Connect helps locate assets that can be used for data 
preparation. It provides a catalogue and metadata of all the 
assets, which are built collaboratively and in compliance with IT. 
Alteryx Promote helps deploy, manage, and monitor predictive 

and machine learning models in production. That is enabled by 
embedding Alteryx, R, and python models in production 
applications and referencing them through APIs. 
 

1.2   Alteryx Gallery 
 
The Alteryx Gallery is a public version of Alteryx Server where the 
community can upload interesting data streams, share ideas, and 

get inspired. The Alteryx Gallery can be accessed at 
gallery.alteryx.com. 
 

https://gallery.alteryx.com/#!
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1.3   The Alteryx Interface 
 
By the end of this chapter, the reader should be able to 
understand all aspects of the Alteryx Designer Interface and how 

to work with the product. 
 

 
 

 
Above is what we might see when we open Alteryx Designer. 
Alteryx Designer asks us what we want to do with the session. It 
is fairly clear that these options are to open up pre-built sample 
workflows to help the user understand how data is transformed 
in Alteryx, to open an existing module, or to open a new module. 
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The first thing we will do is 
create our module and save 
it. Open the file dropdown at 
the top left of the screen, and 
select the New Workflow 
option. Then click on the file 
dropdown again and click 
the Save As option. 

 
You can save your data stream as one of three file types. At a high 
level, we have the ability to save our data stream as follows: 

• .yxmd 

Files saved in this format are data streams in a 
standard Alteryx Workflow. 

• .yxwz 
Files saved in this format are data streams that have 

been designed as Analytic Applications, which means 
they have user inputs and can be run on Alteryx Server. 

• .yxmc 
Files saved in this format are data streams that have 
been designed as Macros that allow the reuse of the 
data stream. 
 

Please save this workflow as The Basics.yxmd. 
You can also save a workflow to the Alteryx Gallery, which is 
hosted either on premise or on the cloud. While saving a 
workflow to the Alteryx Server Private Gallery, you can assign 
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the workflow to run on a specific worker if you have been given 
worker assignment permissions. 
 
You can save multiple workflows as a workflow group, which 
can then be opened as one workflow group file (.yxwg). 
 
You can save all open workflows at the same time by pressing 
Ctrl + Shift + S. 
 

1.4   The Interface 
 

 
 
This is one potential view of the Alteryx Designer Interface if every 
View option is on. The numbers represent each of the seven 
primary aspects of the interface. One through six can be disabled 
and will be discussed under the corresponding sections in View. 
The seventh is the canvas, where we build workflow
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1.5   File Menu 
 
The File Menu functions in the same way as most programs, with 
a few specialized options: 
 
New Workflow: Opens a blank canvas to work in. Ctrl+N means 
there is a Hot Key that allows us to use this action without 
opening the dropdown. Pressing the Ctrl and N buttons at the 
same time does the same thing as selecting New Workflow (Hot 
Key: Ctrl+N). 
Open Recent: Opens a list of the most recently opened workflows.  
Open Workflow: Opens a file browser that allows us to open an 
existing Workflow, Analytic App, or Module in a tab of the canvas 
(Hot Key: Ctrl+O). 
Open Autosaved Files: By default, Alteryx saves your open 
workflows every 10 minutes, maintains the last three iterations 
of them, and keeps them for 30 days since the last save. To edit 
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the Autosave settings, go to the Advanced tab under Options > 
User Settings > Edit User Settings. 
Save <File Name>: Saves the workflow that is in the active canvas 
(we will see the name of the current workflow instead of <File 

Name>) (Hot Key: Ctrl+S). 
Print: Prints a copy of the workflow. 
Print Setup: Opens a window that allows us to configure how the 
workflow will print if we choose to print a copy. 
Exit: Closes Alteryx Designer entirely. This differs from Close 
because Close will close the active canvas, and Exit will close 
every open data stream. 
 

1.6   Edit Menu 
 
Undo: Allows us to undo the steps just performed, in reverse 
order (Hot Key: Ctrl+Z). 
Redo: Allows us to restore a step from what was undone, as long 
as we have not changed anything else (Hot Key: Ctrl+Y). 
Cut: Allows us to remove the selected items on the canvas while 
keeping a copy on the clipboard (Hot Key: Ctrl+X). 
Copy: Allows us to copy the selected items on the canvas to the 
clipboard (Hot Key: Ctrl+C). 
Paste: Allows us to take the most recent thing copied or cut into 
the clipboard and put it on the canvas (Hot Key: Ctrl+V). 
Delete: Removes the selected items on the canvas (Hot Key: Del 
or Delete). 
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1.7   View Menu 
 
Toolbar: Turns the toolbar on and off. When it is checked, the 
buttons on the toolbar are visible (1 in Figure 1-5) (Hot Key: 
Ctrl+Alt+B). 
Tool Palette: Turns the tool palette on and off. When checked, we 
will see the two rows of drag-and-drop tools (2 in Figure 1-5) 
(Hot Key: Ctrl+Alt+T). 
Overview: Turns the overview window on and off. When 
checked, we can see a high-level overview of our canvas (3 in 
Figure 1-5) (Hot Key: Ctrl+Alt+V). 
Results: Displays the Results window docked in its last visible 
position (Hot Key: Ctrl+Alt+R). 
Configuration: Displays the Configuration window docked in its 
last visible position (Hot Key: Ctrl+Alt+C). 
Interface Designer: Turns the interface designer window on and 
off. When it is checked, we will see a window that allows us to 
modify the user interface (6 in Figure 1-5) (Hot Key: Ctrl+Alt+D). 
Find Tool: Opens a pop-up window that allows us to quickly find 
particular tools on the canvas (Hot Key: Ctrl+F). 
The close (X) button was removed from the Overview, Results, 
Configuration, and Interface Designer windows. You can still 
choose which windows to display using the View menu. 
 

1.8   Options Menu 
 
Run Workflow: Runs the workflow. Ctrl+R will also run the 
workflow. The icon changes to Cancel Workflow while the 
workflow is running. 
Schedule Workflow: Allows us to set up a schedule to run our 
workflow, if we have Alteryx Server. 
View Schedules: Allows us to look at all the scheduled jobs we 
have access to on Alteryx Server. 
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Run Analytic Apps: Allows us to run the Alteryx Analytical Apps 
we have created. 
Export Workflow: Allows us to export the workflow along with the 
packages we have created. 
Manage Licenses: Opens a window that allows us to look at 
historical license keys and see what we currently have available. 
Manage Connect Credentials: Opens a window that allows us to 
sign in to our Alteryx Connect account using a URL for the 
instance we want to connect to. 
Add Promote Connection: Opens a window that allows us to sign 
in to our Alteryx Promote account using a URL for the instance 
we want to connect to. 
User Settings: Opens a window that allows us to customize the 
way the canvas looks and the way some of the default settings 
behave. 
Advanced Options: Allows us to manage aliases, workflow 
dependencies, and encrypted workflows. 
Download Predictive Tools: Allows us to download tools for the 
purpose of predictive analytics from the Alteryx repository. 
 

1.9   Help Menu 
 
Alteryx Help: Opens the Alteryx Help home page. 
What’s New: Opens the Alteryx Help release notes for the version 
of Alteryx we are currently using. 
Getting Started: Opens the Alteryx Getting Started page that is 
loaded in the beginning. 
Sample Workflows: Allows us to access the Sample Workflows that 
are shipped with Alteryx. Fourteen new tutorials are added in 
the current version, available from the Help > Tutorials menu. 
Community: Opens the Alteryx Community web page. 
Check for Updates: Checks our current version of Alteryx Designer 
and verifies if it is the most recent version. 
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Alteryx Downloads: Opens the Alteryx Download page where we 
can find additional downloadable content. One example is the 
U.S. Census data. 
 
About: Opens a window that tells us version, publisher, and serial 
number information about Alteryx Designer. 
 

1.10 Samples 
 
Under the Help Menu, there is the option to open Tutorials. The 
sample workflows under the tutorials section is a good starting 
point to learn about the Alteryx tools we do not know. 
 

Walking through the samples is beyond the scope of this book, as 
all the samples are well documented and show how to build the 
workflow step-by-step.  
 

1.11 User Settings 
 
Edit User Settings: Opens a pop-up window so the user can edit 
the settings that affect the way Alteryx Designer looks and 

behaves.  
Save Layout & Settings on Exit: Allows Alteryx to copy the settings 
we had when Alteryx was last closed, as the default when we 
next open the program.  
Save Layout & Settings Now: Allows us to tell Alteryx to use the 
settings we currently have as the default behavior for the 
program.  
Restore Defaults: Allows us to revert Alteryx Designer to the 
default settings. 
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1.12 Tool Palette 
 

 
 

The tool palette is one of the most important aspects of the 
Alteryx Designer interface. It is the easiest way to bring the tools 
onto our canvas. In the section below called Canvas, we will 
discuss the alternative method. 
 
Below are the three main elements of the tool palette:  

• Search: Located in the top-right corner of the tool palette, 
this element allows us to type something into the bar and 
see every tool associated with that word displayed in the 
Tool Selection. 

• Add/Remove Tools: Located to the far right, below Search 
and next to the Tool Categories, this element allows us to 
access, add, or remove all the tools grouped into categories 
that Alteryx has defined. We can add to this list by 

developing macros, which we will discuss toward the end 
of the book. 

• Tool Selection: This is a dropdown when we type in the 
search box and shows all tools meeting either the criteria 
of the Search or Tool Category we have selected. 

In the Tool Categories, there is one special category called Favorites. 
It is special because it does not have tools of its own. Instead, we 
can add and remove tools from this list by clicking the star at the 
top-right corner of each tool. When it is yellow, it means it will 
show up in the Favorites Category. When we cannot see the star 
unless we point our mouse at the tool and it shows up gray, that 
means it isn’t in the Favorites Category. 
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The arrows on either side of the Tool Categories offer the ability to 
scroll across to see each of the categories. We see that, by default, 
Favorites doesn’t follow this behavior. That’s because it is pinned 
outside the scroll arrows. We can do this with any of the 
categories by right-clicking on them and selecting Pin <Category 
Name>. To unpin a category, right-click the category name and 
select Unpin <Category Name>. 
 

 
 

We can see in Figure 1-7 an option called Show Deprecated Tools. 
Selecting this option shows tools that belong to outdated versions 
of Alteryx. If we need a former functionality, we can access it 
here. 
 

 
 

All these categories may not be available to all users because 
Alteryx has many additional downloadable packages in addition 
to the basic package. One example is that if we hadn’t chosen to 
download the Predictive package when we downloaded Alteryx 
Designer, we wouldn’t see the Predictive Category. We will only 
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cover the basic package in this book, plus some downloaded 
content. 
 

1.13 Overview 
 
Below is a picture of the canvas and overview window with a 
simple data stream that is too wide to see what is happening in 
the view of the canvas. The right side of the image is the Overview 
window, and it shows the view of the canvas in relation to the 
entire workflow. 
 

 
 
In addition to showing where we are, the overview window 
makes it easy to find the part of our program we are interested in 
because we can move the view of the canvas by clicking and 
dragging the white box in the overview window. 
 

1.14 Results Window 
 
Every time we run a workflow, we will get a series of returns that 
let us know things about the run. Below is one example of that. 
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In this run, we can see we had 0 Errors, 0 Conversion Errors, 0 
Warnings, 2 Messages, and 2 Files. The counts here reflect the 
notes we see about the run in the text portion of the Output 
window. We have six notes instead of the four we would expect 
from the counts of the messages. That is because the first note is 
that the workflow started to run, and the last note is that the 
module has finished the run. Even if we have no issues or 
messages during the run, we will still have these two notes 
because they are always written. The last message changes 
depending on whether or not we have any errors during our 
execution. The output window is important in diagnosing issues 
with the data stream. 
 

• Errors: These are critical failures that will terminate the 
data stream they are in. 

• Conversion (Conv) Errors: These are potentially problematic 
issues stemming from a data mismatch when converted 
from one format to another. 

• Warnings: These are things we should be aware of but 
could be expected, so the results are printed in the Output 
for us to know about. 

• Messages: These are text in the program designed to print 
when certain stages of the data stream have been finished 
or certain conditions were met. 

• Files: These are links that will allow us to open any file 
created during the running of the workflow. 
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1.15 Properties Window 
 
The properties window is where we will spend the vast majority 
of our time. Every tool has a different properties window, and we 
will discuss each of them as we discuss the individual tools. Here, 
we will discuss the properties window of the workflow and 
connections. 
There is a pane on the left side of every properties window that 
has a universal set of symbols. We will discuss each of these as 
they first appear in this book. A list of all these symbols is in 
Appendix E. 
 
Workflow Configuration 

  
 

Notice the button that looks like a wrench at the top left of each 
of these properties’ windows. Selecting the wrench shows the 
configuration window so we can modify the settings of the tool. 
As we discuss other tools, the importance here will become 
apparent. 
 
A click on the symbol opens the Alteryx help page. 
A symbol at the bottom-left corner is an apply button. We can 
click it to apply the changes we have made. We do not need to 

click the button; we can simply click anywhere on the canvas. 
The first tab of the Workflow Configuration window is Canvas. We 
can change three things in this window:  
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• Layout Direction is a dropdown list that allows us to rotate 
our data stream from a horizontal layout, which is the 
default, to a vertical layout, which is the layout for older 
versions of Alteryx. We must set either Horizontal or 
Vertical and cannot use a combination of the two. 

• Annotations is a dropdown list that allows us to change 
what the text boxes under Tools say. When this option is 
set to Hide, the text does not show. When this option is set 
to Show, the default text is shown for each tool. When this 
option is set to Show w/Tool Names, the annotations tell us 
what the tool names are, as well as the default text. 

• Connection Progress is a dropdown list that allows us to 
change when we see the progress labels on each of the 
tools. By default, this is set to Show Only When Running, 
but we can also set it to Hide and Show, which will never 
or always show the last run’s progress, respectively. 

•  

 
 
The next tab is Workflow. 

• The Path (file location) shows up in this box when the file 
has been saved. 
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• The Type allows us to choose which format the file should 
be. This is also where we select the type of Macro we want 
to create. (This will be discussed in The Mermaid Coffee 
Company chapter.) 

• The Constants section allows us to define variables we can 
use throughout our Alteryx Module.  

 
 

The Runtime tab allows us to configure settings that impact the 
way Alteryx runs. 

• The Dedicated Sort/Join Memory Usage allows us to set the 
maximum amount of memory Alteryx is allowed to use 
for the Sort and Join functions, which can be highly 
memory-intensive. 

• The Temporary Files setting allows us to define the folder 
our temporary files are written to. 

• The Conversion Errors setting allows us to change the way 
the workflow behaves if it experiences conversion errors, 
including limiting them from showing up for each tool 
and stopping the workflow if they occur. 
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• The Record for All Inputs setting allows us to set a 
maximum number of records read from any of our input 
files. 

• The Cancel Running Workflow on Error is useful if we are 
trying to diagnose a specific issue in a workflow. 

• The Disable All Browse Tools should be set after we finish 
testing and the process is in production. We want to do 
this because Browse tools are slow to create and 
unnecessary unless testing. It’s better to use this than to 
delete all the tools because it will make modifying the 
workflow later easier. 

• Show All Macro Messages allows us to see the messages 
we’re getting in the macro tools so when we are running a 
workflow, we can see everything that may be an issue. 

• Disable All Tools That Write Output is useful for testing 
because we can turn off only the outputs so we are not 
rewriting the data every time we run the workflow. 
 

 
 

The Events tab allows us to define events that will allow 
secondary actions to take place. When we add an event, we can 
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choose to define a command line code or send an e-mail when a 
condition is met. That is useful for security or maintenance 
because we can set up our workflows to let us know anytime the 
workflow ran or anytime it ran with issues.  
The Meta Info tab allows us to define meta information about our 
workflow. That is important when we are publishing a workflow 
to Alteryx Server or the public Alteryx Gallery. 
 

 
 

• Workflow Name allows us to customize what we want the 
workflow to be called (independent of the file name) so 
versioned workflows can have the same name, as far as 
the end user is concerned. 

• The Description is a place for us to describe what the 
workflow does. 
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• The URL and Display Test fields allow us to identify where 
the module is published. 

• The Author section allows us to publish information about 
us and our company along with the workbook. 

Connection Configuration 
When using the default settings, connections are the curved black 
lines that connect one tool to the next. 
 

 
 

The Connection Configuration window has the following three 
components:  

• Name allows us to rename our data connection. That is 
most useful when we have multiple data connections 
going into the same tool connector. 

• The Wireless checkbox allows us to make the connection 
wireless (invisible) unless one of the tools it connects is 
selected. 

• The Fields box allows us to see some of the metadata about 
each field in the data stream in this connection. 
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1.16 Interface Designer 
 
The Interface Designer is a window used in developing apps and 
macros. That is where we get to design the user interface the end 
user will see.  

 
 

The default tab view of the Interface Designer window is of the 

Layout View, which allows us to design the user interface in a 

graphic format. The Interface Designer, like the Properties 

window, has a sidebar that tells you what you are looking at. 

From top to bottom, the icons are as follows: 

• Layout View, where we design the interface graphically. 

• Test View, where we see what the end user would see. 

• Tree View, where we look at the structure of our questions 
in a tree structure. 

• Properties, where we set properties associated with the 
interface (independent of the Properties window itself). 

In the Layout View, we design the interface and have a significant 
amount of flexibility in what we can do.  

 
The first and most intuitive thing to do is rearrange questions in 
the order they need to be asked by the end user. We can do this 
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by clicking the up and down arrows on the right side. We may 
notice that while we are moving questions, they sometimes move 
within a box that frames the question we were trying to pass. 
That is because we can make one question determine if the other 
is also asked. By leaving a question inside another, we make that 
question dependent. 

 
 

The next thing we can do is select the Add dropdown menu and 
see that we can add any of the following four things: 

• Group Box: a text element we can put questions in 

• Label: a text element we cannot put questions in 

• Link: a hyperlink in the interface 

• Tab: a tab in the interface 
 

When we are working with the Interface Designer, we will be 
opening the Properties windows associated with whichever tool 
we have selected at the time. Following is an example of the 
properties window for the Label option described above. 
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All windows ask what we want the element in the interface to be 
called, and Link also asks us what link address we want to add to 
the interface. In addition to these questions, we see for the first 
time that we have new icons in the sidebar of the Properties 
window. 

 
 

• Navigation: Allows us to move directly to the incoming or 
outgoing tools. 

• Annotation: Allows us to change how this tool is named 
and how its annotation behaves. 

 
Navigation and annotation are part of every tool properties 
window, and they always behave the same. 
Below are examples of a Check Box Navigation and Annotation 
window when connected to a tool. 
 

 
 

We can see that Navigation lists the tool this Check Box is 
connected to and tells us it’s an outgoing connection. That means 
the Action is downstream of the Check Box. If the Wireless box 
were checked, the wire would be invisible. We will discuss both 
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tools, as well as wireless connections, in the chapters called 
Applications Wanted and Metamorphosis.  
 
The Annotation window tells us the tool is a Check Box with the 
ID number 2, which means it will try to execute this tool second 
if there are no outside influences. We then can change the name 
of the tool. We can change the annotation setting specific to this 
tool as well as provide a custom annotation (this will show up 
under the tool in the data stream). 
 

 
 

Looking back at the Interface Designer, Test View allows us to 
answer the questions in the same way the end user would so we 
can test the app.  
 
TreeView allows us to look at our user interface as a tree structure 

so it’s easier to make sure our logic is properly grouped.Interface 

Designer Properties allows us to customize many aspects of our 

app or macro. 

1.17 Canvas 
 
The default canvas view of the Alteryx Designer has five 
elements: (1) tab name, (2) dropdown list of all the tabs, (3) button 
to allow the user to instantaneously add workflow to the 
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scheduler on the server, (4) button to run the workflow, and (5) 
white area that reads “Drop tools here.” The overview, output, 
interface designer, and properties windows allow us to move 
them around the screen by clicking and dragging their title bar. 
When we do this, we can snap them into the window by 
dropping them on one of the arrows you will see with drag-and-
drop, or you can let it float in front of the canvas or other 
windows by letting go of it while not over an arrow. 
 

1.18 Using Tools 
 
Data streams start with some sort of data source, and in most 
cases, that will be the input tool. From there, we can do a series 

of operations before bringing the data back together to look at it.  
We will cover each of these methods in detail in the next chapter, 
but for now, we will look at the structure of a data stream.  
 

 
 

This Alteryx Workflow takes input data from a file called Test.txt, 
splits the data stream (doubling the data), adds a new field to one 
side, and brings the two streams together to be viewed. 
 
Notice that there are two types of arrows on the incoming (left) 
side of the tools. A green arrow indicates that a single input can 
be connected there, while a gray double arrow indicates that 
multiple connections can be made.  
 
We can see there is no parallel tool on the outgoing (right) side of 
the tools, despite the data stream having multiple outgoing 
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connections. That is because every tool allows us to branch the 
data stream off into many directions.  
 
There are two ways to bring tools onto the canvas. We can drag 
the tool from the Tool Palette or right-click on the canvas and 
navigate the menu on the next page.  
 

1.19 Insert Tool Menu 
 
As an alternative to using the tool palette to insert new tools in 
the canvas, you can right-click on the canvas to add tools using 
the Insert Tool Menu. Simply navigate that menu to find the tool 
you’re looking for. 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 




	Blank Page
	Blank Page

